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1. FB002 Robotic Platform Overview 

This manual will explain how to assemble and configure your FiveBOT robot. Please 
take your time to carefully read through this manual. 
 
The FiveBOT002 is designed for robotic research and development.  The FiveBOT002 
can be used as a transporter, a remote monitoring device and a Navigation/Patrol robot. 
 
The maximum load capacity of the FiveBOT002 is 20kg.   
 
The FB002 comes with 4 mecanum wheels controlled by 4 DC motors, allowing 
clockwise/anti-clockwise rotation as well as sideways movement.  The robotic platform’s 3 
ultrasonic sensors allow the robotic platform to detect objects or avoid obstacles. 
 
The FiveBOT002 robotic platform’s maximum load capacity is 20kg.  This load can 
be placed on top of the platform. 
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2. FB002 Mecanum 4WD Parts List 
 
FB002 Mecanum 4WD Parts List 

ID Part 
Number 

Part Name QTY Accessories Check 

1 12053 Chassis 
Body 

1  

 
2 12056 Front Sonar 

Mounting 
Bracket 

1  

 
3 12060 Battery 

Mounting 
Bracket 

2  

   

4 12061 Chassis 
Cover Plate 

1  
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5 14087 100mm Al 
Mecanum 
Wheel ,Left 

2  

   

6 14092 100mm Al 
Mecanum 
Wheel, Right 

2  

   

7 18005 Wheel Hub 
Assembly 

4  

   

8 16002 DC Motor 4 Pre-installed 
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9 12016 Ultrasonic 
Rubber 
Grommet 

8  

   
10 95002 Hex 

Screwdrivers 
1 2 pieces set 

   
11 12040 Power switch 

charging 
socket 

1 One main 
power switch, 
one charge 
socket, one 
power switch 

   

 
 
FB002 Electronic Components  

ID Part Number  Part Name QTY  Accessories Check 
1 22002 Arduino Board, Atmega328 1    
2 22006 Arduino Expansion V1.2 1   
3 20012 Ultrasonic Sensor Module 3 Cable, Screws  
4 71001 Motor Encoder Cable 4   
5 71005 Arduino USB Cable 1   
6 80011 Ultrasonic Cable & Screws 3   
7 71006 Jumper Cable 3   
8 80005 Controller Screws Bag 1   
9 80017 Battery Mounting Bracket Screws 1   
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FB002 Mecanum 4WD Chassis Construction  
Welcome to your new FB002 Mecanum 4WD Robotic Platf orm! Please take 
a moment to remove all of chassis parts from the bo x and check all of parts 
against the parts list before commencing assembly.  
 
Please note: A Phillips screwdriver is required for  assembly and is not 
included.   
 
 
 

Step 1  –Take out the chassis 
body from the packaging.  
The chassis body has the DC 
motors and their couplers 
pre-installed. 

 

Step 2 – Take off the chassis 
cover plate by undoing the 
screws with a Phillips 
screwdriver. 
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Step 3  – Take out the 
Arduino motherboard (part 
#22002) and attach 4 screws 
and 4 spacers as illustrated. 

 

Step 4 – install the 
motherboard into the chassis 
as shown.  You will need to 
install 4 more screws into the 
opposite side of the chassis, 
as indicated by the black 
arrows.   
 
Next, Install 6 rubber 
grommets as indicated by 
the red arrows. 
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Step 5  – Install 2 spacers and 
2 screws onto each of the 
ultrasonic sensors. 

 

Step 6  – Now p lace the 
ultrasonic sensors into the 
rubber grommets and secure 
the screws as shown by the 
red arrows. 
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Step 7 – Install the batteries 
and battery mounting plates 
and screw them into the 
opposite side using the 
Battery Mounting Bracket 
Screws (part #80117).  These 
screws are indicated with 
blue arrows. 
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Step 8  – Install the wheels 
using the Wheel Hub 
Assembly parts (part 
#18005). 

 

Step 9  -  Your FB002 4WD 
chassis construction is now 
complete! 
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Sample Wiring Installation 
 
The FB002 sample code assumes that the motors and ultrasonic sensors are positioned 
as shown.  The ultrasonic sensors are pre-addressed and their addresses are written on 
each of the boards.   
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Wiring instructions for sample code 
 

The diagram below illustrates an example of how to connect the Arduino control board to the 

sensors, motors and battery. Please pay particular attention to the battery connections. Wiring 
these incorrectly will cause damage to the controller.  
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Quiet PWM mode 
You may optionally wish to increase the PWM frequency of the Arduino board which will help the 

motors to operate more quietly.  For this you need to modify the sample code slightly and add 3 

jumper wires; 

Uncomment the following two lines of code from the Setup() section of the sample code: 
 //    TCCR1B=TCCR1B&0xf8|0x01;    // Pin9,Pin10 PWM 31250Hz 

 //    TCCR2B=TCCR2B&0xf8|0x01;    // Pin3,Pin11 PWM 31250Hz 

Then locate the section of the code segment labeled “Motor control pins” and modify the code 

according to the table. 

Original code  Replace with 

#define M1 4   #define M1 2 

#define E1 5 #define E1 3 

#define E2 6 #define E2 11 

#define M2 7 #define M2 12 

#define M4 11 #define M4 7 

After that, you will need to add three jumper wires according to the following diagram:  
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6. Arduino control board information 
A. Please read this section carefully before applying power to the Arduino control board.  
B. The control board is not designed for military or medical purposes and therefore cannot be used for these 
applications. 
C. The FB002 sample code can be found within this user guide, on the accompanying CD and also under 
the support section of the Fivebro International website – www.fivebro.com.tw. 
 
 
Introduction 

The FB002’s Arduino control board is a specially modified Arduino board designed especially for robotics 

applications. Built from the Arduino open source platform, it is supported by thousands of open source codes 

and can be easily expanded with most Arduino Shields. The integrated 2 way DC motor driver and wireless 

socket gives you a much easier way to start your robotic project. 

 

Specification 

� Atmega328P microcontroller 

� 14 Channels Digital I/O 

� 6 PWM Channels (Pin11,Pin10,Pin9,Pin6,Pin5,Pin3) 

� 8 Channels 10-bit Analog I/O 

� USB interface 

� Auto sensing/switching power input 

� ICSP header for direct program download 

� Serial Interface TTL Level 

� Supports AREF 

� Supports Male and Female Pin Header 

� Integrated sockets for APC220 RF Module 

� Five IIC Interface Pin Sets 

� Two way Motor Driver with 2A maximum current 

� 7 key inputs 

� DC Supply：USB Powered or External 7V~12V DC。 

� DC Output：5V /3.3V DC and External Power Output 

� Dimensions：90x80mm 

�  
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Arduino Control Board Layout 

 

The picture above shows all of the I/O lines and Connectors on the controller, which includes: 

� One Regulated Motor Power Input Terminal (6v to12v) 

� One Unregulated Servo Power Input Terminal (you supply regulated 4v to 7.2v) 

� One Servo input power selection jumper 

� One Serial Interface Module Header for APC220 Module 

� Two DC Motor Terminals – Handles motor current draw up to 2A, each terminal 

� One IIC/TWI Port – SDA, SCL, 5V, GND 

� One Analog Port with 8 analog inputs – one input is tied internally to the supply voltage 

� One General Purpose I/O Port with 13 I/O lines – 4,5,6,7 can be used to control motors 

� One Reset Button 

� Jumper bank to Enable/Disable Motor Control 
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Arduino control board pin jumpers 

Servo power select jumper 

As most servos draw more current than the USB power source can supply, a separate servo power terminal 

is provided to power the servo individually which can be Enable/Disable by the Servo Power Select Jumper. 

When the Servo Power Select Jumper is applied, the servo is powered by an internal 5V. 

When the Servo Power Select Jumper is not applied, the servo is powered by an external power source. 

 

Motor control pin jumper 

Applying the Motor Control Pin Jumpers will allocate Pins 4, 5, 6 and 7 for motor control. 

Removing the jumpers will release the above pins. 

 

Wireless select jumper 

Applying the Wireless Select Jumper will allow the controller to communicate via a wireless module such as 

the APC220. If no wireless module is plugged in, this jumper will not make any difference. 

Removing the jumper will disable wireless module and allows the sketch to be uploaded. 

 

Button enable jumpers 

Applying these jumpers will enable push buttons S1 through S7. 
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Powering the Arduino control board 

Applying power 
 
This is one of the most important steps in getting your control board up and communicating with your host 
controller.  Your control board can be powered from its USB port (connected to your computer), from its 
motor power input or from its servo power input.  Power from the USB port will provide the control board with 

enough power to upload and run sketches, but not enough power to drive servos or DC motors; for these 
applications, use power from the 6-12V Motor Power Input (shown on page 15). 

 

Please note: When applying power to either the Motor Power Input or the Servo Power Input, please ensure 

you use the correct polarity.  Reverse Polarity will damage the controller. We are not responsible for such 

damage, nor does our warranty cover such damage.  Please make sure you take time to apply the power 

correctly! 

 

 

Power from the servo power Input:  

You MUST make sure that you apply power to the Power Terminal using the correct polarity (refer to 

“Arduino control board Layout” on page 15.)   

 

Power from motor power input:   You MUST make sure that you apply power to the Power Terminal using 

the correct polarity (refer to “Arduino control board Layout” on page 15.) 

 

From USB:  Simply connect your control board to your computer via USB cable, and the controller is able to 

work. Please note that the USB can supply a maximum current of 500 mA. It should be able to meet the 

most requirements for LED applications, however it is not enough to power servos or DC motors. 
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Uploading sample code to the Arduino control board 

For this section you will need: 

� Arduino IDE (Integrated Development Environment) software 

� The FB002 sample code 

The Arduino IDE (Integrated Development Environment) is a piece of software that allows you to write 

programs on your computer and then upload them onto the Arduino control board.  The control board 

included in this package can be programmed using Arduino IDE version 0014 and above. It is included on 

the CD but can also be downloaded directly from the Arduino website at http://arduino.cc/en/Main/Software.   

You will also need the FB002 sample code file.  It is located on the accompanying CD and it is also supplied 

on the Fivebro international website (http://www.fivebro.com.tw) under the support section. 

Once you have downloaded and extracted both of these files, you can execute the file named “arduino.exe” 

and you will be presented with a screen that looks like this: 
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The next step is to simply connect the Arduino control board to your computer using the USB cable supplied 

(part #71005). 

 

Please note:  The Arduino expansion board cannot be plugged in while uploading any programs. 

 

Using your Arduino IDE software, click File > Open > and then point the browser to the location where you 

have downloaded the FB002 sample code.  

After doing so your Arduino IDE software should look like this: 
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 Now click Tools > Board > then select “Arduino Diecimila, Duemilanove, or Nano w/ ATMega328”. 

 

Next, click File > Serial Port > and then choose one of the serial ports listed.  Ports COM1 and COM2 are 

usually already reserved by your computer, so try COM3 or above. 

Finally upload the program to the board by pressing the  icon.  This will compile the sketch and upload 

it into your Arduino control board.  If uploading is successful your Arduino IDE should look like this: 
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If communication with the control board fails, please try selecting a different serial port.  If you still cannot 

succeed in connecting, please refer to the troubleshooting section of the Arduino website at: 

http://arduino.cc/en/Guide/Troubleshooting 
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Tutorials 

 
Button Press Tutorials   

The controller has 7 built-in buttons, labelled S1-S7. Buttons S1-S5 use analog pin A7, S6 uses digital pin 

D2 and S7 uses digital pin D3. 

To enable S6 and S7, apply the rightmost two of the “button enable jumpers” (shown on the layout diagram, 

page 15. Once these enable jumpers have been applied, digital pins 2 and 3 will be occupied by the push 

buttons. 

 
 
// Sample code 1:  One-button LED switch 
//Code function: Pressing button S6 turns LED on, pressing it again turns it off. 
 
 
int ledPin = 13;                 
int key_s6 = 2;              
int val=0; 
 
void setup() 
{ 

  pinMode(ledPin, OUTPUT);      // Set Pin13 to output mode 
  pinMode(key_s6, INPUT);       // Set Pin12 to output mode 

} 
void loop() 
{ 

   if(digitalRead(key_s6)==0)  { 
        while(!digitalRead(key_s6)); 
        val++; 
   } 

 
if(val==1)  {  
digitalWrite(ledPin, HIGH);   //  
} 
    
if(val==2)  { 
        val=0; 
        digitalWrite(ledPin, LOW);    // 
} 

} 
 
 
 
 
 
 
 



 Fivebro International Corp. 23 

// Sample code 2:  Two-button LED switch 
//Code function: Press button S6, turn on LED, Press button S7, turn off LED. 
  
 
int ledPin = 13;                 
int key_s6 = 2;                  
int key_s7 = 3;      
             
void setup() { 

pinMode(ledPin, OUTPUT);       
pinMode(key_s6, INPUT);        
pinMode(key_s7, INPUT);        

} 
void loop() 
{ 
   if(digitalRead(key_s6)==0)    
     { 
         digitalWrite(ledPin, HIGH);    
     } 
 
   if(digitalRead(key_s7)==0)   
     { 
         digitalWrite(ledPin, LOW);     
     } 
} 
 
 
Dual DC Motor Speed Control 

 

Pin Allocation 

 
 

"PWM Mode" 

Pin Function  

Digital 4 Motor 1 Direction control 

Digital 5 Motor 1 PWM control 

Digital 6 Motor 2 PWM control 

Digital 7 Motor 2 Direction control 
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"PLL Mode" 

Pin Function  

Digital 4 Motor 1 Enable control 

Digital 5 Motor 1 Direction control 

Digital 6 Motor 2 Direction control 

Digital 7 Motor 2 Enable control 
 

PWM Control Mode  

The PWM DC motor control is implemented by manipulating two digital IO pins and two PWM pins. As 

illustrated in the diagram above, Pin 4,7 are motor direction control pins, Pin 5,6 are motor speed control 

pins. 

 

// Sample code3: Standard PWM DC control 
//Code function: Open Arduino IDE’s serial monitor.  Sending the character “w” will 
cause motors M1 and M2 to spin forward for 1 second.  Sending the character “s” will 
cause the same motors to spin backward for 1 second. 
 
#define LED 13  //pin for the LED labelled "L" 
 
//motor control pins 
unsigned char E1=6; 
unsigned char E2=5; 
unsigned char M1=4; 
unsigned char M2=7; 
 
int incomingByte = 0; // for incoming serial data 
 
 
void setup() { 
 Serial.begin(9600); 
} 
 
void advance() //advance 
{ 

analogWrite(E1,100); 
digitalWrite(M1,HIGH); 
analogWrite(E2,100); 
digitalWrite(M2,HIGH); 
return; 

} 
void back_off () //Move backward 
{ 

analogWrite (E1,100); 
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digitalWrite(M1,LOW); 
analogWrite (E2,100); 
digitalWrite(M2,LOW); 

} 
 
void stop() //stop 
{ 

analogWrite(E1,0); 
digitalWrite(M1,HIGH); 
analogWrite(E2,0); 
digitalWrite(M2,HIGH); 
return; 

} 
 
 
void loop() { 
 

if (Serial.available() > 0) { 
 

// read the incoming byte: 
incomingByte = Serial.read(); 
 
// say what you got: 
Serial.print("I received: "); 
Serial.println(incomingByte, DEC); 
 
if (incomingByte == 119) {  // press "w" 

advance(); 
delay(1000); 
stop(); 

} 
 
if (incomingByte == 115) { //press "s" 

back_off(); 
delay(1000); 
stop(); 

} 
} 

} 
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I/O Expansion Board 

To support RS485 interface or drive 4 motors, I/O Expansion Board is available. 

 

 
Above: Arduino main controller board combined with the expansion board 
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3. Limited Warranty  

FIVEBROFIVEBROFIVEBROFIVEBRO    ONE YEARONE YEARONE YEARONE YEAR    LIMITED WARRANTYLIMITED WARRANTYLIMITED WARRANTYLIMITED WARRANTY    
Fivebros warranty obligations for this FiveBOT (this “Product”) are limited to the terms set forth below. 
Fivebro International Corp. (“Fivebro”) warrants to the original end-user purchaser that this Product will be free from defects in 
materials and workmanship under normal use for a period of 180 days from the date of retail purchase (the “Warranty Period”). 
This warranty is extended only to the original end-user purchaser of a new product that was not sold “as is”. 

If a defect arises: 
(1) you may within 1 year  from the date of retail purchase (or such other period specified by the return policies of the place of purchase) 
return this Product to the place of purchase, together with the original proof of purchase and either the original box or the UPC code label 

from the box, and this Product will be replaced or, in the event that a replacement for this Product is not available at the place of purchase, 
either a refund of the purchase price for this Product or an store credit of equivalent retail value will be provided; or 
(2) you may after the day that is 30 days from the date of retail purchase (or such other period specified by the return policies of the place 
of purchase) and within the Warranty Period contact Fivebro Customer Support to arrange for the replacement of this Product. In the event 
that a replacement for this Product is not available this Product will be replaced by Fivebro with a product of equivalent or greater retail 
value. 
A purchase receipt or other proof of the date of retail purchase is required in order to claim the benefit of this warranty. 
If this Product is replaced, the replacement product becomes your property and the replaced Product becomes Fivebros 
property. If the place of purchase refunds the purchase price of this Product or issues a store credit of equivalent retail value, this Product 
must be returned to the place of purchase and becomes Fivebros property. 

EXCLUSIONS AND LIMITATIONS 
This warranty covers the normal and intended use of this Product. This warranty does not apply: (a) to damage caused by 
accident, abuse, unreasonable use, improper handling and care or other external causes not arising out of defects in materials or 
workmanship; (b) to damage caused by power line surge, lightning or acts of God; (c) to damage caused by service performed by 

anyone who is not an authorized representative of Fivebro; (d) to any hardware, software or other add-on components installed 
by the end-user; (e) if this Product has been disassembled or modified in any way; (f) to faulty installation or set-up adjustments; 
(g) to consumable parts, such as batteries, unless damage has occurred due to a defect in materials or workmanship; (h) to 

cosmetic damage, including but not limited to scratches, dents or broken plastic, or normal wear and tear. Regardless of whether 
the camera is in use or not,exposure to extremely bright lights or objects can damage the CMOS camera sensor. This warranty 
specifically excludes any damage to the CMOS sensor resulting from exposure to extremely bright lights or objects, whether 
accidental or deliberate. 

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS AND YOU MIGHT ALSO HAVE OTHER RIGHTS THAT VARY FROM STATE 
TO STATE. FIVEBROS RESPONSIBITLITY FOR PRODUCT DEFECTS IS LIMITED TO THE REPLACEMENT OF THIS PRODUCT OR 
THE REFUND OF THE PURCHASE PRICE FOR THIS PRODUCT. ALL EXPRESS AND IMPLIED WARRANTIES, INCLUDING BUT NOT 

LIMITED TO ANY IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, 
ARE LIMITED IN TIME TO THE TERM OF THIS LIMITED WARRANTY. NO WARRANTIES, WHETHER EXPRESS OR IMPLIED, WILL 
APPLY 

AFTER THE EXPIRATION OF THE LIMITED WARRANTY PERIOD. If any term of this warranty is held to be illegal or unenforceable, 
the legality or enforceability of the remaining terms shall not be affected or impaired. 
EXCEPT AS PROVIDED IN THIS WARRANTY AND TO THE EXTENT PERMITTED BY LAW, FIVEBRO IS NOT RESPONSIBLE FOR 
DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES HOWSOEVER CAUSED RESULTING FROM BREACH OF 
WARRANTY 
OR CONDITION OR UNDER ANY OTHER LEGAL THEORY, INCLUDING BUT NOT LIMITED TO LOSS OF USE. THE FOREGOING 
LIMITATION SHALL NOT APPLY TO DEATH OR PERSONAL INJURY CLAIMS, OR ANY STATUTORY LIABILITY FOR INTENTIONAL 
AND 
GROSS NEGLIGENT ACTS AND/OR OMISSIONS. 
SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, OR 
LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THESE LIMITATIONS MIGHT NOT APPLY TO YOU. 

Valid only in R.O.C. and U.S.A. 
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Manufactured and distributed by 2010-2011 Fivebro International Corp. 
Product names, designations, and logos are trademarks or registered trademarks 
of Fivebro International Corp. All right reserved. 
 
Fivebro International Crop. 
1105 Room, 11F, No. 206, Song Jiang Rd., 
Taipei City 10467, Taiwan, R.O.C. 
Email: sales@fivebro.com.tw 
Web: www.fivebro.com.tw 
 
Customer service line: +886 2 2562 8445 
Customer support: support@fivebro.c 
 
We recommend that you retain our address for future reference.  
Product and colors may vary. 
Printed in Taiwan. 
This product is not suitable for children under 3 years 
 
This user manual should be kept as it contains important information. 
 


